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1. Introduction 

1.1 Installing PSpice 

The CD accompanying the Reference Book (First Course on Power Electronics 

by Ned Mohan and published by www.mnpere.com) contains the files needed for 

installing the evaluation version of PSpice 9.1. Follow the instructions in the file: 

Readme_PSpice.doc. 

1.2 Simulation as a Three-Step Process 

1. Open a circuit file under Schematics 

2. Simulate 

3. Plot results using Probe. 

 

2. Getting Started Using an Example 

(Note: Selecting and clicking refer to clicking the left mouse button once.) 

2.1 Open a Schematic 

• To open the schematics editor, click on the following: Start - Programs – PSpice 

Student – Schematics. 

• Under the 'File' menu, click on 'Open' and select ‘Schematics’ for file types. 

  Navigate or type in the following filename with the full path name, for example,  

  C:\ FirstCourse_PE_Book09\buckconv.sch and click on 'Open' button. 

 

Fig. 1 Schematic file “Buckconv.sch” 
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2.2 Simulate 

• Get familiar with the icons on the upper toolbars and the right-side toolbar by 

placing the cursor on each icon and waiting a few seconds for the explanation. 

• Click on the run icon  to simulate (or under the 'Analysis' menu, click on 

'Simulate'). 

• The PSpice simulation status window shows up which indicates the simulation 

status. 

• This simulation is set up to run Probe automatically to plot the voltage and 

current, selected by the markers in the schematic, at the end of the simulation. 

 

2.3 Plotting Results using Probe 

• Look at the plotted results.  Probe has created this plot using the raw plot points in 

the file Buckconv.dat created by the transient simulation. 

• Exit probe by clicking on two 'X' buttons on the upper-most right hand corner. 

 

3. Getting to know PSpice by an Example 

3.1 Schematic on the screen 

Now, we will explore various components, which make up the buck-converter 

schematic on our screen.  Note that PSpice is case insensitive, that is, uppercase 

and lowercase letters mean the same.  We have the option of using the following 

suffix letters to indicate various power-of-ten:  

Suffix value 

f 10-15 

p 10-12 

n 10-9 

u 10-6 

m 10-3 

k 103 

meg 106 

g 109 
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• Each circuit should have one node designated as the ground node, which is 

connected to the 'AGND' symbol. 

• Select and double click on the DC voltage source ‘Vd’. A dialog box opens 

up.  Uncheck “Include Non-changeable Attributes” and “Include System-

defined Attributes”.  The dialog box then displays only the properties we 

would normally want to change.  For the dc voltage source, we have only one 

property o modify – ‘DC'. Click on the entry ‘DC’ in the list box, and enter 

the value in the edit field above.  Click ‘Save Attr’ to register the change.  If 

you want to display the value on the schematic page, click ‘Change Display’, 

and select the required option under ‘What to Display’. 

• Double click on the inductor symbol.  The inductor has a value of '5uH'  

where 'u' stands for 'micro' and 'H', the unit of inductance, is ignored by the 

program.  The initial inductor current is A given in the ‘IC’ field.  The 

inductor current direction is defined from pin1 to pin2.  

• Similarly, double click on the capacitance (at the corner of one of its plates) 

and verify that it also can be assigned an initial condition.  The capacitor 

voltage polarity is defined as the voltage at pin1 with respect to pin2. 

• The diode in this schematic is a component in the symbol library 

First_Course_PED supplied with your diskettes (with a part name 'D_pwr').  It 

uses a device model 'd' built-in within PSpice.  Select the diode by double 

clicking near the cathode plate of the symbol and observe that its only 

parameter that can be changed is its resistance 'rs', which at present is 

assigned a value of 1mΩ. 

• The switch is a voltage-controlled switch which is a part 'v-switch' in 

First_Course_PED.  This switch symbol uses the PSpice model of a voltage-

controlled switch designated by 'vswitch' which has a very low resistance 

RON in its on-state, when the control voltage is greater than VON.  When the 

control voltage is less than VOFF, the switch is represented by a very high 

resistance ROFF.  The default values are as follows: RON=1 ohm, 

ROFF=1E+6 ohm, VON=1 V, and VOFF= 0 V.  Note that the current through 

this switch can flow in either direction when the switch is on.  Double click on 
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this switch.  Only its on-state resistance 'ron' can be changed, which, at 

present, is assigned a value of 1mΩ. 

• In the PWM controller, the control voltage is compared with a high frequency 

sawtooth waveform, which establishes the switching frequency fs which in 

this circuit is 100 kHz.  The symbol PWM_SAW comes from the PE_Lib1 

library.  It has two terminals: c, where the control voltage is applied and s, 

where the output is provided to control the switch. 

♦ Double-click on the symbol of the PWM controller to see the sub-

schematic which makes it up.  The control voltage at the c terminal is 

subtracted by a sawtooth waveform generated by a voltage source.  

Double click on the voltage source symbol and notice that in this 

‘VPULSE’ source, the initial voltage level V1 is 0V.  It rises to V2 of 

1V with a delay time TD of 0s, a rise time TR of nearly 1/fs, and a fall 

time TF and a pulse width PW, both nearly zero.  The period PER is 

1/fs.  Ideally, the rise time should be 1/fs, and the fall time and the 

pulse-width should be zero.  In order to avoid convergence problems 

in PSpice, the fall time and the pulse width are given a small but finite 

value of 0.01 us.  Notice that { } and @ are needed in this hierarchical 

arrangement, where the value of the frequency fs is passed on from the 

buck schematic where it can be changed.  The ABM block takes in 

two inputs, which are processed as per the EXP1 attribute.  Notice 

how the two inputs are referenced in ‘EXP1’. 

• In the schematic, the Markers are placed on nodes for plotting their voltages 

and on component pins for currents going into those pins.  Under the 'PSpice' 

menu, select ‘Markers’ and see that we have a choice of markers: voltage 

level (with respect to ground), differential voltage across two nodes, current 

into pin (or terminal) of a component, as well as advanced markers (such as 

voltage in dB) that become available if appropriate to the simulation. 

• Note that all the components are connected by wires. 
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3.2 Setting up the simulation  

Under the 'Analysis' menu click ’Setup’.  In the dialog box that appears, make 

sure that the checkbox near ‘Transient’ pushbutton is checked.  Click on 

‘Transient’ to edit the settings for transient analysis.  The most important 

parameters for transient analysis are Final Time, the time till which the simulation 

is to be run, and Step Ceiling, the maximum time step the simulation can use.  

Also, make sure that Skip initial transient solution is checked.  This prevents the 

program from calculating its own initial conditions based on bias-point 

calculations; rather the user-supplied initial conditions, if any, are used. 

 

To setup probe, from ‘Analysis’ menu, click ‘Probe Setup’.  Notice that 

‘Automatically run Probe after simulation’ is selected under ‘At Probe Startup’.  

Select the ‘Data Collection’ tab where ‘All’ is selected.  There is also a button for 

‘At markers only’.  This option is important; it should be selected appropriately in 

a large circuit where collecting data at all nodes for a long transient simulation 

may result in an excessive simulation time and in a very large data file. 

 

4. Drawing a Schematic from Scratch 

  Now, we will draw the same buck-converter schematic from scratch. 

• Close the current schematic by clicking on the ‘x’ button the upper-right 

corner, discarding any changes. 

• Go to the 'File' menu and click on 'New'. A new schematic window opens. 

4.1 Linking the needed symbol libraries to this schematic 

Before we bring in parts, make sure that we have the appropriate symbol libraries 

available for this schematic.  Normally, a new schematic will have all the default 

PSpice libraries loaded.  However, we will have to make sure that the symbol 

library supplied with the course is loaded properly.  To check if it is so, click on 

‘Draw’ menu, and click ‘Place Part’, (alternatively, use the toolbar icon .  In 

the Place Parts dialog box, click ’Libraries’.  Make sure that 

‘First_Course_PED.slb‘ is included in the list of libraries.  If not, use the 
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procedure given in Sec. 1.6 to add the library.  Click ‘Cancel to return to the Place 

Parts dialog box. 

4.2 Bringing parts to the schematic 

Click on the place part icon and the dialog box will open up.  In the parts list, 

select ‘VDC’ (typing the name in the text box above the list helps in quickly 

searching for the part).  Click ‘Place& Close’.  The dialog box closes, and you 

should be able to get the symbol of ‘VDC’ attached to the mouse.  Left click the 

mouse to place the part at the desired location.  While moving the part, press 

‘Ctrl-R’ to rotate the part.  Once you have placed the part, click ‘Esc’ to end the 

operation, or keep placing copies of the part by left-clicking the mouse on other 

locations on the schematic. 

 

Do the same with the rest of the components to build the schematic in Fig. 1.  

Notice that the ground to be used is ‘AGND’. 

To manipulate existing components, select them by left-clicking the mouse.  Drag 

the component to a new location, press Ctrl-R to rotate, and Ctrl-F to flip.  To 

delete the component, press ‘Del’. 

To connect the components by wire, from ‘Draw ‘ menu, click ‘Wire’ (icon  

from the toolbar).  Make sure that the circuit is wired correctly. 

4.3 Setting up Simulation 

• Follow the procedure detailed in Sec.3.2. 

4.4 Running the Simulation 

• Save the Schematic: Under the 'File' menu, select 'Save’ 

• Start the Analysis: Start the simulation by clicking on the run icon . 

• Exploring the Probe: Within Probe, explore many possibilities by pulling 

down various menus.  For example in a plot, one or more waveforms can be 

scaled, waveforms can be labeled, certain portion of the plot can be zoomed 

in, limits on the axes can be manually specified, two or more waveforms can 

be combined (for example, multiplied point-by-point) and plotted.  More than 

one plot can be arranged one below the other, another Y-axis can be added. 

• Printing Probe Waveforms: With waveforms on the screens select 'Page Setup' 

from the 'File' menu. Select all margins as 0.5”, choose 'Portrait' and '3 
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plots/page', and cursor information on bottom.  Click on 'OK'. Under ‘File’ 

menu choose 'Print'.  Click on 'OK'. 

• Taking the waveforms to a word processor: Under the ‘Window’ menu, 

choose ‘Copy to clipboard’.  Make sure to choose ‘Make window and plot 

backgrounds transparent’.  In the ‘Foreground’ box, check ‘Change all colors 

to black’ (unless you have a color printer).  Now these waveforms can be 

pasted into the word processing program. 

• Printing the Schematic: Switch to Capture so that your schematic is on the 

screen.  By choosing ‘Print’ under the ‘File’ menu will print the entire page 

which will make the schematic very small.  The suggested procedure is as 

follows: Draw a box around the part of the schematic you want to print. This 

will select it.  Under ‘Edit’ Menu, click on ‘Copy’.  Paste it in a word 

processing program.  In Microsoft Word, right click on the pasted schematic 

and format picture where its size can be adjusted and under ‘Picture’ tab, 

choose ‘Black and White’ in the color box.  

 

5. PSpice-Supplied Libraries and Components 

To draw a schematic, we need components which are stored in symbol libraries.  All such 

libraries except for First_Course_PED are part of PSpice loaded from the CD-

ROM/downloaded file.  This section contains the list of components from the PSpice 

libraries that are most likely to be used in power electronics simulations. 

• Passive Components from the Analog library 

 Resistor R, Inductor L, Capacitor C, Coupled Inductors, XFRM_LINEAR 

• Independent Voltage and Current Sources from the Source Library 

 Vdc, Idc, Vpulse, Ipulse, Isin and Vsin.  For piece-wise-linear definition of 

voltage and current as a function of time, use VPWL and IPWL.  Note that 

Vac and Iac are for sweeping frequencies in ac analysis (used in frequency-

domain analysis). 

• Dependent Voltage and Current Sources from the Analog Library 

 Voltage-controlled voltage source E, Current-controlled current source F, 

Voltage-controlled current source G, and Current-controlled voltage source H. 

• Ground Symbol from the right-side Toolbar 
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 The ground symbol to be used for simulations has to be AGND or 

GND_ANALOG or GND_EARTH. 

• Avoiding Wires and using Bubble 

 Select ‘BUBBLE’ from the parts list (The component is part of library 

‘Port.slb’.  Make sure that the library is linked to the schematic before using 

the part).  By double clicking on the symbol, it can be renamed.  Bubbles with 

the same name connect the nodes to which they are attached. 

• Interface ports from library ‘Port.slb’ 

 Interface ports are used to connect nodes across multiple pages and also for 

hierarchical connections. 

• Analog Controller Modeling using ABM Elements 

- Get an ABM element from the ABM library.  Make sure that the ABM library 

is included.  The output of this block is a voltage (with respect to ground) 

equal to the expression in this block.  This expression can be changed by 

double clicking on the expression. 

- Get an ABM1 element from the ABM library.  The output of this block on the 

right side is a voltage (with respect to ground) equal to the expression in this 

block which relates the output to the input voltage v(%in).  This expression 

can be changed by double clicking on the expression. 

- Get an ABM2 element from the ABM library.  Similar to the ABM1 element, 

this element relates output to the two input voltages v(%in1) and v(%in2).  

Enter the entire expression in EXP1 and delete EXP2 entirely. 

- Get an ABM3 element from the ABM library.  Similar to the ABM2 element, 

this element relates output to the three input voltages v(%in1), v(%in2) and 

v(%in3).  Double click on the part to edit attributes. Delete EXP2 and EXP3 

entirely and enter the expression in EXP1. 

- Similar in use as ABM elements, ABM/I, ABM1/I, ABM2/I and ABM3/I 

elements have an output which is a current source in the direction shown. 

- Get the Table element from the ABM library.  The output of this element on 

the right side is a voltage (with respect to ground) related to the input voltage 

by the transfer curve.  This transfer curve can is defined point-by-point with 

increasing input values.  Straight-line interpolation is used between two 
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successive points.  Make sure to delete all default values for this transfer 

curve. 

- Other important elements in the ABM library are: filters (BANDPASS, 

BANDREJ, LOPASS), DIFF, Gain, INTEG, LIMIT, SOFTLIM, MULT and 

SUM. 

• Analog Controller Modeling using Laplace-Domain Transfer Functions 

 Get a LAPLACE part from the ABM library.  Both the numerator and the 

denominator can be changed by double clicking on them. 

• Specifying Parameters by means of PARAM in Special Library 

 Get PARAM from the Special library.  Double click on it.  Enter the name of 

the parameter and its value in the fields NAME1 and VALUE1 respectively.  

Upto three parameters can be set up in the PARAM part.  In using these 

parameters, for example, rather than specifying a numeric value for an 

inductor, we can specify the parameter name within {} brackets; its value is 

specified by the PARAM. 

• Models for a Power Diode, a MOSFET and an IGBT in EVAL Library 

 The evaluation version of PSpice has a model for a power diode D1N4002, a 

MOSFET IRF150, and an IGBT IXGH40N60 in EVAL library.  (Models for 

diode MUR2020, and MOSFET IRF640 are included in PE_LIB1.) 

 

6. Library ‘First_Course_PED’: Specially-Designed for Power Electronics 

Components in the library of symbols are specially designed for simulation of power 

electronic circuits and controllers (not a part of the PSpice Install folder).  Each of these 

libraries can contain a maximum of 15 symbols. 

 

 

 

7. Fourier Analysis 

After a time-domain simulation, it is possible to perform a Fourier analysis on one or 

more of the circuit waveforms.  This is accomplished as follows (see Exercise 3): With 

the schematic on the screen, under the 'Transient' tab of the Simulation setup check 

Enable Fourier in the “Fourier Analysis’ box and provide the necessary information. 
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Note that the Fourier analysis is performed for the last time period corresponding to the 

specified center frequency.  The phase angle for a sine wave starting (at zero) at 

time=tfinal-tperiod is zero.  The amplitudes are in peak values.  After the simulation, the 

Fourier analysis results are contained in the output file, which can be viewed by selecting 

‘Examine Output’ under the ‘Analysis’ menu. 

 

8. Parametric Analysis 

If an attribute of a component is defined by PARAM as described earlier, then it is 

possible to perform a parametric sweep.  This is accomplished as follows (see Exercise 

3): With the schematic on the screen, click on the Simulation Setup icon, select 

‘Parametric’.  Select the global parameter radio button.  Give the parameter name and the 

list of values. 

9. Performance Analysis in Probe 

After the results of a parametric analysis are plotted in Probe, pull down the 'Trace' menu 

and click on 'Performance Analysis...'.  Click on 'OK'.  Under the 'Trace' menu, click on 

'Add'.  You will see the built-in Functions or Macros.  Choose the desired one and add 

the trace and other specification, if any, to the Function or Macro.  It is possible to use 

more than one function or Macro in the 'Trace Expression' to evaluate the desired 

performance.  Click on 'OK'. 

 

10. Analysis of Waveforms using built-in Macros within Probe 

Any of the traces can be analyzed within Probe by built-in macros such as RMS, AVG, 

MIN, MAX, etc.  For a frequency-domain analysis, macros such as DB and P (for phase) 

are available. 

 

11. Frequency Domain Analysis 

1. In Schematics, open the schematic file Buck-Boost_CCM_DCM_Freq_Analysis.sch. 

The circuit schematic shown below should appear in Schematics window. 
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2. In the simulation setup, select AC Sweep/Noise' as the Analysis type.  The sweep 

type should be decade and the frequency range should be from 10Hz to 1MHz with 

101 points per decade. 

3. After running the simulation, the Probe window will show the voltage across the load 

resistor as a function of frequency. This voltage is the transfer function between the 

output voltage and the input duty cycle since the ac duty cycle (given by V7) is equal 

to unity. A more conventional gain and phase plot can also be constructed. First pull 

down the ‘Trace’ menu in Probe and select ‘Delete All Traces’. Then pull down the 

‘Trace’ menu and select ‘Add Trace’. From Functions of Macros, select P().  From 

the 'Add Traces' select V(vo).  Click on 'OK'.  You'll see a Phase plot on your screen.  

From the 'Plot' menu, select 'Add Plot to Window'.  From the 'Trace' menu, select 

'Add Trace' and then DB() from the Functions or Macros.  Once again add V(vo). 

Click on 'OK'.  You will see a Gain plot.   

4. Double click on the X-axis in the bottom plot.  Click on 'Axis Variable'.  In the 'Trace 

Expression' window, type in 2*pi* in front of Frequency.  Click on 'OK'.  Click on 

'OK' again.   

5. Select cursor icon from the tool bar.  Move cursor to 10K.  (Note that the x-axis scale 

is now in rad/s, not in Hz).  On the tool bar, click on 'Mark Label' icon. 

6. Note: The Parametric Analysis and the Performance Analysis can also be carried out 

in the frequency-domain. 

 

12. Avoiding and Overcoming Convergence; Other Useful Hints 
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In modeling of power electronic circuits, convergence and the speed of simulation are 

two of the biggest problems.  The following precautions are suggested. 

1. It may be necessary to include R-C snubbers across diodes, thyristors and switches to 

avoid a sharp discontinuity, which results in PSpice proceeding with a very small 

time step.   

2. Increase the error tolerance ABSTOL to 1u, GMIN to 1u, ITL1 to 400 and ITL4 to 

100.  It may be necessary to increase RELTOL for 0.01.  This can be accomplished as 

follows: with the schematic on the screen, click on Simulation setup and then on 

'Options' tab and change the desired values. 

3. Instead of L, use Lr component, which has a resistance in parallel with the 

inductance.  Similarly, use a small resistance in series with large capacitors and 

voltage sources. 

4. Assign small but finite rise and fall times and pulse width to pulsed sources. 

5. Connect a large resistance across an element, which seems to be causing a 

convergence problem. 

 

Floating Nodes: There must be a dc path to ground from each node.  Otherwise, an 

error message will indicate that a particular node is floating.  A 

simple remedy is to connect a large resistance, for example a 1 

Meg ohm resistance, from that node to ground, which does effect 

the circuit performance.  At each node, there must be at least two 

connections, otherwise the run will abort with an error message.  A 

large resistance from that node to ground will correct this problem. 

 

Inductor Loops: If there is a loop involving inductors with zero resistance, an error 

message will be printed in the .OUT file.  Insert a small resistance 

anywhere in this loop. 


